Wednesday, 4 August

8am  Workshop  
     EXPERT WORKSHOP  
     Stage - Journals Stage

8am  Workshop  
     EXPERT WORKSHOP  
     Stage - SIG Programming Stage

8am  Workshop  
     EXPERT WORKSHOP  
     Stage - Special Session Stage

8am  Workshop  
     EXPERT WORKSHOP  
     Stage - Stage 4

9:30am  General  
       JOURNAL OF INTERNATIONAL MARKETING AWARDS SESSION | S. Tamer Cavusgil Award and Hans B. Thorelli Award  
       Stage - Journals Stage  
       Chaired by: Kelly Hewett

9:30am  General  
       SERVSIG: The Edge of Tomorrow: How AI Shapes the Future of Service Research  
       Stage - SIG Programming Stage  
       Chaired by: Prof. Arne De Keyser and Prof. Jenny van Doorn and Prof. Dominik Mahr and Prof. Chiara Orsingher and Prof. Florian von Wangenheim

9:30am  General  
       The Edge of Tomorrow: How AI Shapes the Future of Service Research  
       » Prof. Jan Hendrik Schumann (University of Passau), Prof. Martin Mende (Florida State University), Prof. Arne De Keyser (EDHEC Business School), Prof. Yakov Bart (Northeastern University), Prof. Xian Gu (Indiana University), Prof. Stephanie Liu (The Ohio State University), Prof. Stacey G. Robinson (The University of Alabama), Prof. P. K. Kannan (University of Maryland), Mrs. Jana Holthöwer (University of Groningen), Prof. Jenny van Doorn (University of Groningen), Prof. Gaby Odekerken-Schröder (Maastricht University), Dr. Kars Mennens (Maastricht University), Mr. Mark Steins (Maastricht University), Prof. Dominik Mahr (Maastricht University), Prof. Chiara Orsingher (University of Bologna), Prof. Katja Gelbrich (Catholic University Eichstätt-Ingolstadt), Mr. Sandro Arnet (ETH Zurich), Prof. Anne Scherer (University of Zurich), Prof. Florian von Wangenheim (ETH Zurich)

9:30am  Oral: Consumer Behavior Track - Session 5  
       Consumer Psychological Processes  
       Stage - Stage 4  
       Chaired by: Marcel Lichters

9:30am  Oral: Consumer Behavior Track - Session 5  
       Does Distance Make the Heart Grow Fonder? How Product-Model Spatial Distance and Ad Appeal Influence Product Evaluation  
       » Mr. Dickson Tok (Nanjing University), Dr. Xi Chen (Nanjing University), Dr. Xing-Yu (Marcos) Chu (Nanjing University)

9:30am  Oral: Consumer Behavior Track - Session 5  
       Too little to clean it up: large size increases product efficacy perception  
       » Ms. Yunzhi Huang (Xiamen University)
Continued from **Wednesday, 4 August**

**BORED OR JOYFUL? DESIGN-DRIVEN CONSUMER EMOTIONS AND PRODUCT SUCCESS**
» Ms. Heike Hebborn (University of Innsbruck), Ms. Janina S. Kuhnle (University of Innsbruck), Dr. Verena Hofmann (University of Innsbruck), Prof. Nicola Stokburger-Sauer (University of Innsbruck)

**Product Bundling and Consumers’ Price Preferences**
» Mr. Seyedjavad Mousavi (The University of Kansas)

**The Power of Aww: A Dual-process Approach to Cuteness-affected Risk Taking and Decision-Making**
» Dr. Alexis Yim (Radford University), Dr. Stephen He (West Virginia University), Dr. Annie Cui (West Virginia University)

**9:30am**

**Oral : Services, Retailing, and Customer Experience Track - Session 1**

**CRM, Loyalty, and Data Privacy**

*Stage - Stage 5*
Chaired by: Prof. Anand Kumar Jaiswal

**FOSTERING THE IMPACT OF BRAND PERFORMANCE METRICS ON CUSTOMER LOYALTY: ROLE OF RELATIONAL QUALITY AND LENGTH**
» Prof. Hardeep Chahal (University of Jammu), Dr. Renu Bala (GCW, Parade, Jammu)

**SQ-EXQUAL: A Hybrid Scale for measuring customer satisfaction and loyalty**
» Prof. Anand Kumar Jaiswal (IIM Ahmedabad), Dr. Suvendu Pratihari (IIM Ahmedabad)

**How Do Relationship Characteristics Affect Point Redemption Behavior in the Coalition Loyalty Programs?**
» Mr. Chen Li (Drexel University), Dr. Srinivasan Swaminathan (Drexel University), Dr. Junhee Kim (California State University, Stanislaus)

**Just Tell Me What You Want...: The Relevance of Information Transparency on the Use and Handling of Customers’ Data**
» Mr. Tobias Roeding (University of Siegen), Prof. Sascha Steinmann (University of Aarhuis), Prof. Hanna Schramm-Klein (University of Siegen)

**Using Customer Education to Boost Positive Word of Mouth**
» Ms. Xiaochi Sun (University of Graz), Prof. Thomas Foscht (University of Graz), Prof. Andreas B. Eisingerich (Imperial College London)

**9:30am**

**Oral : Social Media and Digital Marketing Track - Session 1**

**Emerging Topics in Mobile, IOT, Recommendation Systems and Ad Blockers**

*Stage - Stage 6*
Chaired by: Mr. Hamid Shirdastian

**TRAJECTORY-BASED VERSUS LOCATION-BASED COMPETITIVE MOBILE TARGETING: THE ROLE OF PRIVACY RIGHTS STATUTES**
» Prof. Shan-Yu Chou (Department of Business Administration, National Taiwan University), Prof. Chy-I-Mei Chen (Department of Finance, National Taiwan University)

**Our Relationship with Smart Technology: IoT CRM**
» Dr. Zhan Wang (St. Cloud State University), Dr. Garth Harris (St. Cloud State University)

**App Atmospheric Cues and Cultural Congruency in Location-Based Mobile Ads**
» Mr. Hamid Shirdastian (Concordia University), Dr. Boris BARTIKOWSKI (Kedge Business School), Dr. Michel Laroche (Concordia University), Dr. Marie-Odile Richard (State University of New York Polytechnic Institute)

**INTEGRATED FRAMEWORK FOR RECOMMENDATION SYSTEM PARTICIPATION AND OUTCOMES**
» Mr. An Vu (Victoria University of Wellington), Dr. Mary Ellen Gordon (Victoria University of Wellington), Dr. Jocelyn Cranefield (Victoria University of Wellington)
How Does the Adoption of Ad Blockers Affect News Consumption?
» Ms. Shunyao Yan (Goethe University Frankfurt), Prof. Klaus Miller (Goethe University Frankfurt), Prof. Bernd Skiera (Goethe University Frankfurt)

<table>
<thead>
<tr>
<th>Time</th>
<th>Session</th>
<th>Details</th>
</tr>
</thead>
</table>
| 11am  | Keynote | Innovation Session  
Stage - Plenary Stage |
| 12:30pm | General | AMA Meet the Editor 1  
Stage - Journals Stage |
| 12:30pm | General | SportSIG: Reimagining Sport & Sponsorship-Linked Marketing  
Stage - SIG Programming Stage  
Chaired by: Dr. Ashley Stadler Blank and Mr. Keevan Statz and Dr. Yiran Su and Dr. Michael L. Naraine and Dr. Lane Wakefield |

### Advertising For Social Good
» Mr. Ayan Ghosh Dastidar (Georgia State University), Dr. Sarang Sunder (Texas Christian University), Dr. Denish Shah (Georgia State University)

### Is more always better? Product availability, consumption and marketing influences at the Bottom of the Pyramid
» Ms. Shehzala (IIM Ahmedabad), Prof. Anand Kumar Jaiswal (IIM Ahmedabad), Dr. Vidya Venireddy (IIM Ahmedabad)

### Does Environmental Responsibility Beat Convenience in Online Shopping? An Investigation of Excessive Packaging, Customer Anger and Loyalty
» Mr. Simon Elschenbroich (Universität Innsbruck), Mr. Benedikt Schnurr (Technical University Munich), Prof. Nicola Stokburger-Sauer (Universität Innsbruck)

### Individualism and collectivism as moderators of the relationship between norms and pro-environmental consumer behavior
» Mrs. Selma Saracevic (The Institute for International Marketing Management, WU: Vienna University of Economics and Business), Prof. Bodo B. Schlegelmilch (The Institute for International Marketing Management, WU: Vienna University of Economics and Business), Dr. Tong Wu (Lingnan (University) College, Sun Yat-sen University)

### Beyond Personal Benefits: How Compassion Stimulates Prosocial Behavior and Data Disclosure in Covid-19 Contact Tracing Apps
» Ms. Klara Greinwald (University of Passau), Ms. Eileen Dauti (University of Passau), Ms. Alisa Keller (University of Passau), Dr. Eva Kropp (University of Passau), Prof. Dirk Totzek (University of Passau)
12:30pm **Oral : Sustainability, Social Responsibility and Public Policy Track - Session 4**

**Emerging Topics in Sustainability**

*Stage - Stage 5*

Chaired by: Dr. Vidya Vemireddy

**SYSTEMATIC AND ETHICAL APPROACH TO FOOD EXPERIENCE DESIGN**

» Prof. Michela Addis (Università degli Studi Roma Tre), Prof. Wided Batat (EM Normandie Business School), Dr. S. Sinem Atakan (Siena College), Prof. C. Graham Austin (Montana State University), Prof. Danae Manika (Brunel University London), Prof. Paula Peter (San Diego State University), Dr. Lane Peterson (Georgia State University)

**PRESCRIBED MEDICATION CONSUMPTION FOR CHRONIC ILLNESS: AN UNFOLDING, NARRATIVE, EXPERIENCE PERSPECTIVE**

» Dr. Cheryl Nakata (University of North Carolina at Greensboro), Dr. Lisa Sharp (University of Illinois at Chicago), Dr. Jelena Spanjol (Ludwig-Maximilians-Universität), Prof. Anna Shaojie Cui (University of Illinois at Chicago), Dr. Elif Izberk-Bilgin (University of Michigan-Dearborn), Dr. Stephanie Crawford (University of Illinois at Chicago), Dr. Yazhen Xiao (University of Tennessee)

**Courting Controversy in a Highly Polarized World: Consumer Responses to Brand Activism**

» Mrs. Maria Sava (University of Leeds), Dr. Aristeidis Theotokis (University of Leeds), Dr. Magnus Hultman (University of Leeds), Dr. Vita Kadile (University of Leeds)

12:30pm **Oral : Branding, Innovation and the 4Ps Track - Session 1**

**Firm Strategies for Introducing Innovations**

*Stage - Stage 6*

Chaired by: Dr. Jake Hoskins

**Algorithmic Interference: Infringement on Forming Intimate Associations and the Manipulation of Weak Ties**

» Dr. Patricia Norberg (Quinnipiac University), Dr. Daniel Horne (Providence College)

**Rhetoric-Based Signals of Quality and Narrative Meaning in Crowdfunding Campaigns for New Ideas: Evidence from Kickstarter**

» Dr. Mohammad Tajvarpour (State University of New York at Oswego), Dr. Ashish Pujari (McMaster University, DeGroote School of Business)

**Market Selection and Product Positioning Decisions and their Implications for Short- and Long-Term Performance**

» Dr. Jake Hoskins (Williamette University), Dr. Abbie Griffin (University of Utah)

**Joint Moderating Effects of Innovation Radicalness and Lead Userness in Different Stages on New Product Development Performance**

» Ms. Hyeyeon Yuk (Korea University Business School), Dr. Tony Garrett (Korea University Business School), Dr. Woojung Chang (University of Seoul)

2pm **General**

**JOURNAL OF MARKETING AWARDS SESSION: AMA/MSI/ROOT WINNER**

*Stage - Journals Stage*

Chaired by: Page Moreau

**TURNING A CRISIS INTO AN OPPORTUNITY - INNOVATION DURING THE PANDEMIC**

» Dr. Francesca Bonetti (London College of Fashion), Dr. Alessandra Vecchi (London College of Fashion)
Continued from Wednesday, 4 August

2pm

**General**

*Higher Ed SIG: The Response of Higher Education Institutions to COVID-19*

*Stage - SIG Programming Stage*

Chaired by: Dr. Prachi Gala and Dr. Atefeh Yazdanparast

---

**THE RESPONSE OF HIGHER EDUCATION INSTITUTIONS TO COVID-19**

» Dr. Prachi Gala (Elon University), Dr. Atefeh Yazdanparast (Clark University), Dr. Leonard Berry (Texas A&M University), Dr. Christopher Dede (Harvard University), Dr. David Fithian (Clark University), Dr. Sandeep Krishnamurthy (University of Washington Bothell)

2pm

**General**

*Analytics Insights for Public Policy & Marketing*

*Stage - Special Session Stage*

Chaired by: Dr. Brennan Davis and Dr. Dhruv Grewal

---

**Analytics Insights for Public Policy & Marketing**

» Dr. Brennan Davis (Cal Poly), Dr. Dhruv Grewal (Babson College)

2pm

**Oral: B2B Marketing, Supply Chain Management and Sales Management Track - Session 1**

*Advances in Research on Interorganizational Relationships*

*Stage - Stage 4*

Chaired by: Dr. Swati Panda

---

**Customer–Salesperson Negotiations in Times of Crisis**

» Ms. Claire Cardy (University of Warwick), Prof. Johannes Habel (University of Houston), Dr. Olaf Ploetner (ESMT Berlin), Dr. Nawar Chaker (Louisiana State University)

2pm

**Oral: Consumer Behavior Track - Session 6**

*Ethics, Privacy, and Wellbeing*

*Stage - Stage 5*

Chaired by: Ms. Stella Tavallaei

---

**New Service Development Performance: Examining the Roles of Customer Participation Scope and Customer Relationship Management in Servitization**

» Dr. Todd Morgan (Western Michigan University), Dr. Wesley Friske (Missouri State University), Dr. Paul Mills (Cleveland State University)

**Project Termination: Alliance Portfolio Characteristics and NPD Project Performance**

» Dr. Hadi Eslami (University of New Brunswick), Dr. Farhad Sadeh (Eastern Illinois University), Dr. Kamran Eshghi (Laurentian University)

**Bidirectional agency relationships in solution selling: How supplier and customer opportunism impedes customer acceptance of outcome-based pricing**

» Dr. Eva Kropp (University of Passau), Prof. Dirk Totzek (University of Passau)

---

**Let’s go(,) bananas! - How emotionalized humanization increases consumers’ liking of imperfect food produce**

» Ms. Svenja Hünies (RWTH Aachen University), Prof. Daniel Wentzel (RWTH Aachen University)

**Examining Situational Skepticism due to Health-related Claims on Packaged Food Products and its Effect on Product Purchase Intention**

» Ms. Vartika Chaudhary (IIT Bombay), Prof. Dinesh Sharma (IIT Bombay), Prof. Anish Nagpal (University of Melbourne)

**Consequences of Consumer Burnout**

» Ms. Hannah Southern (Elon University), Dr. Prachi Gala (Elon University)
EMOTIONAL INTELLIGENCE AND MATERIALISM: THE MEDIATING EFFECT OF SUBJECTIVE WELL-BEING
» Dr. Beata Seinauskienė (Kaunas University of Technology), Dr. Ausra Rutėliūnė (Kaunas University of Technology), Dr. Shahrokh Nikou (Åbo Akademi University), Dr. Rosita Lekavičienė (Kaunas University of Technology), Prof. Dalia Antiniūtė (Lithuanian University of Health Sciences)

AN EXPLORATORY ASSESSMENT OF CONSUMER EMOTIONAL INTELLIGENCE IN CONSUMER ETHICAL DECISION MAKING
» Dr. Hannah Walters (Northern State University)

2pm
Oral: Social Media and Digital Marketing Track - Session 3
The Impact of Social Media Advertising, Online Advertising, and Online Search
Stage - Stage 6
Chaired by: Ms. Lisa Schwayer

Owned Social Media Advertising: Cannibalization and Competition
» Prof. Hualu Zheng (Professor), Prof. Lu Huang (New York Institute of Technology)

Is Disclosure Good for Online Ad Effectiveness? The Crowd Safety Effect of Collective-Based Transparency
» Dr. Junjun Cheng (Shanghai University), Dr. Bo Chen (Sungkyunkwan University)

THE ANCHORING EFFECT IN ONLINE SEARCH
» Dr. Satadruta Mookherjee (NEOMA Business School), Dr. Abhimanyu Bhattacharya (University of Alabama), Mr. Herman Blote (University of Groningen)

SMILE?! – THE ROLE OF CONSUMERS’ SELF-CONSTRUAL, ENDORSERS’ EMOTIONS AND AD APPEAL FOR SOCIAL MEDIA COMMUNICATION SUCCESS
» Ms. Lisa Schwayer (University of Innsbruck), Prof. Nicola Stokburger-Sauer (Universität Innsbruck), Dr. Verena Hofmann (University of Innsbruck)

Effects of Social Media Ads on New Product Perception and Behavioral Intention
» Dr. Eric Van Steenburg (Montana State University), Ms. Kaitlin Lane (Montana State University)

3:30pm
General
JOURNAL OF MARKETING AWARDS SESSION: SHETH/JM + HUNT/MAYNARD WINNERS
Stage - Journals Stage
Chaired by: Robert Palmatier and Harald Van Heerde

General
Stage - SIG Programming Stage
Chaired by: Dr. Stacy Wood and Dr. Kevin Schulman

» Dr. Stacy Wood (North Carolina State University)

3:30pm
Oral: Social Media and Digital Marketing Track - Session 4
Social Media, Social Networking, and the Role of Sentiment and Satisfaction
Stage - Stage 4
Chaired by: Ms. Ashley Hass
Continued from Wednesday, 4 August

THE PERCEPTION OF CONSUMER ENVY ON SOCIAL NETWORKING SITES
» Dr. MURONG MIAO (Northern Michigan University), Dr. Yi Peng (Tennessee Tech University)

Why do users participate in Social Commerce? Changing Trends and Insights from a longitudinal study?
» Mr. Ashish Kakar (Texas Tech University), Dr. Adarsh Kumar Kakar (Alabama State University)

Platform Pricing in the Presence of Cross-platform Network Effects
» Ms. Betty Ji (McMaster University, DeGroote School of Business), Dr. Ruhai Wu (McMaster University, DeGroote School of Business)

Returns to Social Media and the Role of Customer Satisfaction
» Mr. Pushpinder Gill (Iowa State University), Dr. Sridhar Ramaswami (Iowa State University), Ms. Preetinder Kaur (Iowa State University)

Fanning the Flames: Understanding Viral Content After Brand Transgressions
» Dr. Kimberly Legocki (St. Mary’s College), Dr. Kristen Walker (California State University, Northridge), Dr. Meike Eilert (University of Kentucky)

3:30pm Oral : International & Cross-Cultural Marketing Track - Session 1
Cross-national Consumer Behavior Research
Stage - Stage 5
Chaired by: Prof. Gianfranco Walsh

INFLUENCE OF EMOTIONAL VENTING ON THE EFFECT OF CONSUMER ANIMOSITY
» Dr. Yi Peng (Tennessee Tech University), Dr. MURONG MIAO (Northern Michigan University), Mr. Siyuan Yang (Tennessee Tech University)

What Drives Opinion Leadership Within Ethnic Subgroups?
» Prof. Gianfranco Walsh (University of Jena), Prof. Ayalla Ruvio (Broad College of Business), Prof. Mario Schaarschmidt (University of Jena)

A CROSS-CULTURAL INVESTIGATION OF CONSUMER IMPULSIVE BUYING BEHAVIOR DURING THE COVID-19 PANDEMIC
» Ms. Pei Wang (Florida State University), Dr. Sindy Chapa (Florida State University)

Consequences of Unethical Firm Behavior: How do consumers evaluate local brands and global brands that behave unethically?
» Ms. Irem Yoruk (Wayne State University), Dr. Attila Yaprak (Wayne State University)

3:30pm Oral : Marketing Analytics, AI, Machine Learning Track - Session 1
Recent Trends in AI and Machine Learning
Stage - Stage 6
Chaired by: Dr. Xianfang Zeng

Advice and Artificial Intelligence: Seek Advice from Humans Versus Machines
» Dr. Xianfang Zeng (University of Wisconsin-River Falls)

Conducting relevant generalizations of past results in Marketing research: Introduction to the one-stage meta-analytic structural equation modeling.
» Kathleen Desveaud (TSM-Research, Université Toulouse Capitole, CNRS), Prof. Mike WL Cheung (National University of Singapore)

Distributive justice and welfare values of blockchain-based smart contracts
» Prof. Nir Kshetri (University of North Carolina at Greensboro)

A Text Mining Approach to Generate Actionable Intelligence & Identify Key Drivers of City Competitiveness
» Mr. Ayan Ghosh Dastidar (Georgia State University), Dr. Denish Shah (Georgia State University)
Thursday, 5 August

8am  Workshop
EXPERT WORKSHOP
Stage - Journals Stage

8am  Workshop
EXPERT WORKSHOP
Stage - SIG Programming Stage

8am  Workshop
EXPERT WORKSHOP
Stage - Special Session Stage

8am  Workshop
EXPERT WORKSHOP
Stage - Stage 4

9:30am  General
JOURNAL OF PUBLIC POLICY & MARKETING AWARDS SESSION |
Thomas C. Kinneer/ Journal of Public Policy & Marketing Award
Stage - Journals Stage
Chaired by: Kelly Martin and Maura Scott

9:30am  General
RM SIG Session
Stage - SIG Programming Stage
Chaired by: Hui Fend and Alok Saboo and Naveen Donthu and Anders Gustafsson and P.K. KANNAN and Prof. Kelly Hewett and JOHN HULLAND

9:30am  Oral: Sustainability, Social Responsibility and Public Policy Track -
Session 1
Sustainability and Triple Bottom Line Performance
Stage - Stage 4
Chaired by: Dr. Fabio Shimabukuro Sandes

Feeling small but thinking big: Awe-induced positive self-
diminishment motivates sustainable consumption
» Ms. Srinwanti Chaudhury (University of New South Wales), Dr. Nitika Garg (University of New South Wales), Dr. Colin Gabler (Ohio University)

Environmental, Social, and Corporate Governance Strategic Group
Dynamics and the Role of Chief Marketing Officer and Chief
Sustainability Officer
» Dr. Charles Kang (University of Wisconsin-Milwaukee)

Sustainability positioning in retail: latent semantic analysis of
social media marketing communication
» Ms. Nadezda Kolesnik (National Research University Higher School of Economics)

An Investigation of Retail Price Competition Under Carbon Tax
» Mr. Syed Mohammad Ali Shah (McMaster University, DeGroote School of Business), Dr. Ruhai Wu (McMaster University, DeGroote School of Business)

How to build a strong brand relationship for sustainable products:
Evidence from a large-scale field experiment and survey
» Ms. Katharina Glaen (RWTH Aachen University), Prof. Malte Brettel (RWTH Aachen University)
9:30am

Oral : Consumer Behavior Track - Session 7
Social Relationships and Identities
Stage - Stage 5
Chaired by: Monika Imschloss

How Linguistic Style Affects Word-of-Mouth’s Persuasion Effect over Different Identity Source
» Dr. Jie Chen (Shanghai Jiao Tong University Antai College of Economics and Management), Ms. Wenjian Fan (Shanghai Jiao Tong University Antai College of Economics and Management), Mr. Junlong Wei (Shanghai Jiao Tong University Antai College of Economics and Management), Dr. Zunli Liu (Shanghai University of Engineering Science)

Antecedents of Bundle Purchases - The Influence of the Customer-Retailer Relationship and Browsing on Bundle Purchases
» Ms. Marie-Therese von Buttlar (RWTH Aachen University), Dr. Andrea Greven (RWTH Aachen University), Prof. Malte Brettel (RWTH Aachen University)

Visual Illusion of Truth Effect
» Ms. Farhana Tabassum (BI Norwegian Business School), Dr. Klemens Knoeferle (BI Norwegian Business School), Prof. Luk Warlop (BI Norwegian Business School)

THE EFFECT OF TYPOGRAPHY ON BRAND CREDIBILITY: THE MEDIATING ROLE OF THE MESSAGE PERSONA
» Dr. NESENUR ALTINIGNE (Istanbul Bilgi University), Mrs. Deniz Ozbayrak (Istanbul Bilgi University)

Making Purchase Decisions in the Absence of Touch: An Examination of the Role of Price Framing and Sale Proneness
» Dr. Atefeh Yazdanparast (Clark University School of Management), Dr. Monika Kukar-Kinney (University of Richmond Robins School of Business)

9:30am

Oral : Social Media and Digital Marketing Track - Session 5
Online Reviews and User-Generated Content
Stage - Stage 6
Chaired by: Dr. Jake Hoskins

“You Are Kicked Out of the Room Now!”: the Impact of Social Exclusion on User-Generated Content in Online Communities
» Ms. Xiaochi Sun (University of Graz), Dr. Banggang Wu (Sichuan University), Dr. Xuebin Cui (Nanjing University)

It’s a Man's World? Male Dominance of a Product’s Online Community and its Implications for Review Volume, Review Valence and Review Diversity
» Dr. Shelly Rathee (Villanova University), Dr. Jake Hoskins (Willamette University)

The moderating role of marketplace organic search on earned social media and user-generated content: a multilevel multichannel retailing assessment
» Dr. Valter Vieira (State University of Maringá), Dr. Marcos Almeida (Federal University of Goiás), Dr. Thomas Schreiner (University of Hamburg)

EXAMINING THE ROLE OF LATENT CONTENT FACTORS OF ONLINE CONSUMER REVIEWS ON RECEIVER OUTCOMES: AN EMPIRICAL STUDY
» Dr. Vartika Srivastava (SPJIMR; IIT BOMBAY), Prof. ARTI D. KALRO (INDIAN INSTITUTE OF TECHNOLOGY BOMBAY)

Consumer Engagement Behaviours with Micro-Influencers’ Online Product Reviews
» Dr. TAI ANH KIEU (Ho Chi Minh City Open University)

11am

Keynote
Awards Celebration
Stage - Plenary Stage
12:30pm | General
Meet the Editors Special Session for Entrepreneurial Marketing Research
Stage - SIG Programming Stage
Chaired by: Dr. Wesley Friske and Dr. Todd Morgan

Meet the Editors Special Session for Entrepreneurial Marketing Research
» Prof. Fabian Eggers (Associate Editor, Journal of Business Research, Menlo College), Prof. James Crick (Associate Editor, Strategic Journal of Marketing, Loughborough University), Prof. Terrence Brown (Editor in Chief, International Journal of Entrepreneurial Venturing, KTH Royal Institute of Technology), Prof. Victoria Crittenden (Editor in Chief, Journal of Marketing Education, Babson College), Prof. Zubin Sethna (Editor in Chief, Journal of Research in Marketing and Entrepreneurship, Regent's University London), Dr. Wesley Friske (Missouri State University), Dr. Todd Morgan (Western Michigan University)

12:30pm | General
Recent Developments in Marketing Strategies in Competitive Environment
Stage - Special Session Stage
Chaired by: Dr. V Kumar and Dr. Ankit Anand and Dr. Ashley Goreczny and Dr. Amalesh Sharma and Dr. Yusuf Oc

Recent Developments in Marketing Strategies in Competitive Environment
» Dr. V Kumar (Indian School of Business), Dr. Ankit Anand (Texas Tech University), Mr. Amit Agarwal (Georgia State University), Dr. Ashley Goreczny (Iowa State University), Ms. Heather Patterson (Iowa State University), Dr. Amalesh Sharma (Texas A), Dr. Yusuf Oc (King's College London), Dr. Shintaro Okazaki (King's College London), Dr. Stefan Bernritter (King's College London)

12:30pm | Oral: Services, Retailing, and Customer Experience Track - Session 5
Retailing and the Customer Experience
Stage - Stage 4
Chaired by: Mr. Olivier Reimann

Perceptions of the Plus-Size Women's Apparel Market and Strategies for Improving the Industry
» Dr. Mavis Adjei (Southern Illinois University Carbondale)

To Protect and Serve? The Impact of Retailers' Customer Policing Policies on Frontline Employees
» Dr. Patrick Fennell (Salisbury University), Dr. Melanie Lorenz (Florida Atlantic University), Dr. James "Mick" Andzulis (Ohio University)

Always On My Mind? - Antecedents of Private Label Share in Consumers' Consideration Sets
» Mr. Lukas Stoppacher (University of Graz), Prof. Thomas Foscht (University of Graz), Dr. Judith Schloffer (University of Graz)

Attitude Formation towards Economy, Standard and Premium Private Label
» Mr. Olivier Reimann (ZHAW - School of Management and Law), Dr. Oliver Thomas (ZHAW - School of Management and Law), Prof. Gunther Kucza (ZHAW - School of Management and Law)

Business Customer Experience in B2B2C: A Scale Development
» Dr. Rejikumar G (Amrita Vishwa Vidyapeetham), Dr. Aswathy Asokan Ajitha (Indian Institute of Management Amritsar)

12:30pm | Oral: Consumer Behavior Track - Session 2
Behavioral Outcomes of Marketing Strategy
Stage - Stage 5
Chaired by: Karen Anne Wallach

Voice Assistants, Social Norms, and Prosocial Behavior
» Ms. Smaraki Mohanty (Binghamton University, State University of New York), Dr. Iman Paul (Clarkson University), Dr. Samuel Bond (Georgia Tech)
Continued from Thursday, 5 August

Expanding self-extension theory in the Internet of Things
» Ms. Min Yan (Newcastle University), Prof. Raffaele Filieri (Audencia Business School), Prof. Matthew Gorton (Newcastle University)

Old is not always Gold: The role of Temporal Congruence in shaping the downstream effects of Firm’s Longevity
» Ms. Shweta Jha (Indian Institute of Management, Indore, India), Prof. Sanjeev Tripathi (Indian Institute of Management, Indore, India), Prof. Sudipta Mandal (Indian Institute of Management, Indore, India)

Customer’s package-size choice decision at the bottom of the pyramid (BOP) market
» Dr. Suvendu Pratihari (IIM Ahmedabad), Prof. Anand Kumar Jaiswal (IIM Ahmedabad)

The bright and dark side of credit card usage by low-income consumers
» Dr. Farah Diba Abrantes-Braga (Inspur (www.insper.edu.br)), Dr. Danny P. Claro (Inspur (www.insper.edu.br))

Adding Clicks to Clicks: Exploring the Impact of Encroachment on Online Incumbents
» Mr. Karthikeyan Balakumar (Indian Institute of Management Calcutta), Dr. Prafulla Agnihotri (Vijay Patil School of Management), Dr. Ritu Mehta (Indian Institute of Management Calcutta), Dr. Debabrata Ghosh (Malaysia Institute for Supply Chain Innovation)

DIGITAL TECHNOLOGIES AND SHOPPING: AN EXPLORATORY STUDY
» Prof. Piyush Sharma (Curtin University), Dr. Akiko Ueno (Middlesex University), Prof. Charles Dennis (Middlesex University), Dr. Ceyda Paydas Turan (University of Surrey)

Fool me once, shame on you; fool me twice, shame on Amazon Prime
» Dr. Zahy Ramadan (Lebanese American University), Dr. Maya Farah (Lebanese American University), Ms. Rana Bou Saada (Lebanese American University)

Subscription commerce: an attachment theory perspective
» Mr. René Hubert Kerschbaumer (University of Graz), Mr. Daniel Kreimer (University of Graz), Prof. Thomas Foscht (University of Graz), Prof. Andreas B. Eisingerich (Imperial College London)

THE ROLE OF CUSTOMERS’ PERCEIVED VALUE IN THE PRIVACY PARADOX
» Mr. David Fehrenbach (WWU Münster), Dr. Carolina Herrando (University of Twente)

2pm Oral: Services, Retailing, and Customer Experience - Session 2
E-Commerce
Stage - Stage 6
Chaired by: Dr. Zahy Ramadan

2pm General
JOURNAL OF MARKETING RESEARCH AWARDS SESSION | PAUL E. GREEN AWARD
Stage - Journals Stage
Chaired by: Dr. Peter Danaher

2pm General
RAPSIG: Naked, Embarrassing, Cancelled, and Haptic: The Art of Selling Products to a New Generation
Stage - SIG Programming Stage
Chaired by: Dr. Stephanie Noble and Dr. Stacey Robinson

Naked, Embarrassing, Cancelled, and Haptic: The Art of Selling Products to a New Generation
» Dr. Stephanie Noble (University of Tennessee), Dr. Stacey Robinson (The University of Alabama), Dr. Courtney Szocs (Louisiana State University), Prof. Carol Jones (University of Alabama), Dr. Lauren Beitelshpacher (Babson College), Dr. Subhash Iha (The University of Memphis)
**2021 AMA Summer Academic Conference 04 - 06 Aug 2021 All times in PDT**

### Oral: Consumer Behavior Track - Session 1

**Digital Marketing**

**Stage - Stage 4**

Chaired by: Franziska Krause

**Mobile Push Notification Effectiveness: The Role of the Consumer-firm Relationship and Browsing Behavior**

- Ms. Marie-Josefien Schneider  (RWTH Aachen University)
- Dr. Jan Kemper  (RWTH Aachen University)
- Prof. Malte Brettel  (RWTH Aachen University)

**Download This App for Our Own Sake: Factors Influencing Users' Download Intention**

- Dr. Robin Robin  (Oxford Brookes University)
- Dr. Ala' Dandis  (Applied Science Private University)

**Consumers’ De-ownership as a Predictor of Dark-side Digital Acquisition and Digital Piracy Behavior**

- Dr. Monika Kukar-Kinney  (University of Richmond Robins School of Business)
- Dr. Mateja Kos Koklic  (University of Ljubljana)
- Dr. Irena Vida  (University of Ljubljana)

**E-commerce and shoppers’ evolution post-Covid19**

- Dr. Zaby Ramadan  (Lebanese American University)
- Dr. Maya Farah  (Lebanese American University)
- Ms. Alaa J. Sleiman  (Lebanese American University)

**“35 CANDIES FOR A T-SHIRT?”: HOW A VIRTUAL CURRENCY'S DISSIMILARITY TO MONEY DECREASES PURCHASE INTENTIONS**

- Mr. Gianluca Scheidegger  (University of St.Gallen)

### Oral: Consumer Behavior Track - Session 4

**Behavioral Outcomes in the Sharing and Caring Economy**

**Stage - Stage 5**

Chaired by: Prof. Nicole Hess

**A Qualitative Analysis of the Importance of Ownership and other Drivers and Barriers to Participate in Rental-Commerce**

- Mrs. Anne Fota  (University of Siegen)
- Ms. Katja Wagner  (University of Siegen)
- Prof. Hanna Schramm-Klein  (University of Siegen)

**Why Not Set Pen to Paper? How Typeface Design Influence Charitable Behaviors**

- Dr. Xing-Yu (Marcos) Chu  (Nanjing University)
- Mr. Dickson Tok  (Nanjing University)
- Mr. Junjie Gui  (Nanjing University)

**A TEMPORAL PERSPECTIVE OF FOOD WASTE REDUCTION BEHAVIOR**

- Dr. Marwa Gad Mohsen  (University of Buckingham)
- Dr. Lubna Nafees  (Appalachian State University)

**PSYCHOLOGICALLY ACCESSING OWNERSHIP: HOW DOES PSYCHOLOGICAL OWNERSHIP AFFECT PEER-TO-PEER ACCESS-BASED CONSUMPTION?**

- Mr. Otávio Teixeira  (University of Brasilia)

### Oral: Marketing Analytics, AI, Machine Learning Track - Session 2

**Understanding the human-Machine Interactions**

**Stage - Stage 6**

Chaired by: Ms. Stella Tavallaei

**Understanding the robo-advisor adoption: An empirical study by integrating technology acceptance model (TAM) and task technology fit (TTF) model**

- Dr. BINGCHENG YANG  (Sun Yat-sen University)
- Prof. Hongyan Yu  (Sun Yat-sen University)
- Dr. Jianlan Chen  (Sun Yat-sen University)

**Will We Help Others in a Smart City? The Impact of AI Surveillance on Citizens' Sociability**

- Mrs. Emanuela Stagno  (BI Norwegian Business School)
- Dr. Matilda Dorotic  (BI Norwegian Business School)
- Prof. Luk Warlop  (BI Norwegian Business School)
Who resists algorithmic advice?: Cognitive style correlates with algorithmic aversion
» Ms. Heather Yang (MIT Sloan School of Management), Dr. Renée Gosline (MIT Sloan School of Management)

Is It Time to Name Your Best Nonhuman Friends? How Sound Symbolism Mitigates Resistance to Artificial Intelligence
» Ms. Stella Tavallaei (Florida International University), Dr. Jayati Sinha (Florida International University)

Keypoints of message design for voice shopping interactions
» Ms. Lea Sollfrank (Goethe University Frankfurt), Dr. Ju-Young Kim (Goethe University Frankfurt)

3:30pm
General
JOURNAL OF MARKETING RESEARCH AWARDS SESSION | WEITZ WINER O’DELL AWARD
Stage - Journals Stage
Chaired by: Dr. Vikas Mittal

Brief Decision Science Intervention for Changing Negative Attitudes Toward Opioid Agonist Treatment: Results from a Pilot Study in Ukraine
» Dr. Maxim Polonsky (Yale University)

The specter of death and the desire to compete: The influence of mortality salience due to COVID on the evaluation of exclusive luxuries.
» Dr. Nabanita Talukdar (Hult International Business School, San Francisco), Dr. Shubin Yu (HSBC Business School, Peking University, Shenzhen)

The Social Density and Consumer’s Purchase Intention after the COVID-19 Pandemic
» Dr. Yong Wang (Beijing Technology and Business University), Ms. Xue Gu (Beijing Technology and Business University), Dr. Yang Li (Beijing Technology and Business Universit)

UNDERSTANDING THE VARIOUS WAYS CONSUMERS COPE WITH A PANDEMIC CRISIS-A QUALITATIVE APPROACH
» Dr. Melika Kordrostami (California State University, San Bernardino), Dr. Elika Kordrostami (Rowan University)

The Role of External Cues on Consumer Adoption of Cannabidiol (CBD) Products: A Health Belief Model Approach
» Dr. Laee Choi (Colorado State University-Pueblo), Dr. Jiyoung Hwang (The University of North Carolina at Greensboro), Dr. Sanghyuck Park (Colorado State University-Pueblo)

3:30pm
General
AMA Foundation Session
Stage - Special Session Stage

3:30pm
Oral: Consumer Behavior Track - Session 8
Pandemics, Opioid Usage, and Consumer Behavior
Stage - Stage 4
Chaired by: Yeseul Kim

Moral judgement in business negotiation: Personality, society, or self-interest
» Dr. Eran Rubin (University of Akron), Dr. Frederik Beuk (University of Akron)
Continued from Thursday, 5 August

Advancing B2B Social Selling: The relevancy of post personality
» Dr. Roberto Mora Cortez (Southern Denmark University), Mr. Ayan Ghosh Dastidar (Georgia State University)

Control and Justice Perceptions: Multiple Controls and Crowding Out Effects
» Dr. Reza Rajabi (Northern Illinois University), Dr. Tiffany Legendre (University of Houston), Dr. Thomas Brashear Alejandro (University of Massachusetts, Amherst. Fundacao Getulio Vargas)

A Comprehensive Examination of Salesforce Satisfaction and Performance
» Ms. Claire Cha (University of Massachusetts), Dr. Reza Rajabi (Northern Illinois University), Mr. Hossein Hashemi (University of Massachusetts), Dr. Thomas Brashear Alejandro (University of Massachusetts, Amherst)

3:30pm Oral : International & Cross-Cultural Marketing Track - Session 2
International Marketing Strategies
Stage - Stage 6
Chaired by: Mr. Kiwoong Yoo

The influence of language on attitudes toward brands
» Mr. David DeFranza (University of Utah), Dr. Aurl Mishra (University of Utah), Dr. Himanshu Mishra (University of Utah)

» Mrs. Marina Kovalchuk (University of Eastern Finland), Prof. Mika Gabrielsson (University of Eastern Finland), Prof. Andreas Fürst (Friedrich-Alexander University Erlangen-Nürnberg)

Why Not Both? Utilizing Knowledge Management Capability for Market Exploration and Exploitation Among Mexican Firms
» Mr. Jacob Almaguer (University of Texas Rio Grande Valley), Dr. Edith Galy (University of Texas Rio Grande Valley)

Friday, 6 August

8am Workshop
EXPERT WORKSHOP
Stage - Journals Stage

8am Workshop
EXPERT WORKSHOP
Stage - SIG Programming Stage

8am Workshop
EXPERT WORKSHOP
Stage - Special Session Stage

8am Workshop
EXPERT WORKSHOP
Stage - Stage 4
Continued from Friday, 6 August

8am  Workshop  
**EXPERT WORKSHOP**
*Stage - Stage 5*

9:30am  General  
**EBSCO AWARDS SESSION | Part One**
*Stage - Journals Stage*

9:30am  General  
**DocSIG**
*Stage - SIG Programming Stage*

9:30am  General  
**B2B Relationship Development in Dynamically Changing Environment**
*Stage - Special Session Stage*
Chaired by: Mr. Ashish Galande and Ms. Sakshi Babar and Dr. Roberto Mora Cortez

B2B Relationship Development in Dynamically Changing Environment
» Mr. Ashish Galande (Indian Institute of Management Udaipur), Prof. Chris Dubelaar (Deakin University), Dr. Ali Tamaddoni (Deakin University), Prof. Prakash Satyavageeswaran (Indian), Ms. Sakshi Babar (Indian Institute of Management Udaipur), Dr. Sundar Bharadwaj (University of Georgia), Dr. Roberto Mora Cortez (SDU), Mr. Ayan Ghosh Dastidar (Georgia State University)

9:30am  Oral : Sustainability, Social Responsibility and Public Policy Track - Session 2  
**Sustainability and Public Policy**
*Stage - Stage 4*
Chaired by: Dr. Abhijit Roy

Eco-product labeling: The moderating effect of environmental marketing, consumer purchasing evaluation and competitive advantage
» Ms. Debra Lee Surface (University of Massachusetts Lowell)

The role of brands in second-hand product consumption.
» Dr. Fabio Shimabukuro Sandes (Universidade Lusófona, CICANT)

Group Factors Affecting Consumers’ Behavioral Intentions toward Suboptimal Food Products: Perspectives from Consumer Choice Theory and Theory of Planned Behavior- Food Waste Management Perspective
» Mr. Ahmed M. Adel (Huazhong University of Science and Technology), Prof. Xin Dai (Huazhong University of Science and Technology), Mrs. Rana S. Roshdy (Huazhong University of Science and Technology)

BRAND ACTIVISM AND BRAND LEGITIMACY
» Ms. Seoyoung Kim (University of Georgia), Dr. Sundar Bharadwaj (University of Georgia)

Promises and Perils of Consumer Well-Being in the Epoch of IR 4.0: Macro-Behavioral Implications
» Dr. Abhijit Roy (University of Scranton)

9:30am  Oral : Consumer Behavior Track - Session 3  
**Brands and Consumers**
*Stage - Stage 5*
Chaired by: Kaisa Lund
Framing brand misbehavior: Exploring the effects of moral intensity frames on boycott intention
» Dr. Olivia Bravo (University of the West Indies), Dr. Sindy Chapa (Florida State University)

The Influence of Perceived Movement on Consumer Responses to Brand Recovery Efforts
» Dr. Laura Boman (Mercer University), Mr. Lam An (University of Winnipeg), Dr. Ganga Hewage (Bryant University), Dr. Jonathan Hasford (University of Tennessee - Knoxville)

EFFECTIVE MESSAGING STRATEGIES FOR SOCIOPOLITICAL ACTIVIST BRANDS
» Mr. Fayez Ahmad (University of North Texas), Dr. Francisco Guzmán (University of North Texas)

The Influences of Engaging in Fan Communities on Human Brand Loyalty
» Dr. Jeongsoo Han (Middlesex University Dubai), Dr. Mina Jun (Sookmyung Women's University), Dr. Miyea Kim (Barun ICT Research Center, Yonsei University)

A Luxury Consumption Perspective on Motivations for Brand Value Co-creation
» Ms. Shayan Shaikh (University of Warwick), Dr. Michaela Gummerum (University of Warwick)

Effectiveness of Price Adjustment and the Influence of Information Acquisition Cost
» Mrs. Emma Wang (University of Edinburgh), Prof. Jake Ansell (University of Edinburgh), Dr. Kirsten Cowan (University of Edinburgh)

Pop-Up Stores: How They Drive Online Sales and the Moderation Effects of Other Promotion Tools
» Prof. Shuai Yang (Donghua University), Mr. Junjie Wang (Donghua University), Prof. Hualu Zheng (Susquehanna University), Ms. Yahui Liu (Donghua University)

INFLUENCER EQUITY: DEFINITION AND VALUE-CREATION MECHANISMS
» Dr. Essi Pöyry (University of Helsinki), Dr. Petri Parvinen (University of Helsinki)

Effect of Cultural Distances on Online Reviews
» Mr. Rahul Srinivasan (Indian Institute of Management Udaipur), Prof. Prakash Satyavageeswaran (Indian Institute of Management Udaipur), Dr. Sundar Bharadwaj (University of Georgia)

Price Reactions to a Rival's Market Exit: Evidence from the U.S. Airline Industry
» Dr. Amir Javadinia (Florida Atlantic University), Dr. Sina Aghaie (Wichita State University), Dr. Milad Darani (Kent State University)
Reinvigorating the Study of Brand Charisma
- Prof. Cornelia Otnes (University of Illinois at Urbana-Champaign), Prof. Carlos Torelli (University of Illinois at Urbana-Ch), Prof. Maria Rodas Waters (Marshall USC)

Customer Experience with Augmented Reality Technology in Retailing: (In)authentic Self and Reality versus Curiosity and Fun
- Mr. Khaled El Shamandi Ahmed (Henley Business School, University of Reading)

An Experimental Investigation of the Use of Artificial Intelligence in the Context of Complaint Management
- Mrs. Anne Fota (University of Siegen), Ms. Katja Wagner (University of Siegen), Prof. Hanna Schramm-Klein (University of Siegen)

The Impact of Value Congruence and Social Interaction between Founder and Backers on Intention to Invest
- Dr. Tien Wang (Institute of International Management, National Cheng Kung University), Ms. Susan Chrestella Bahari (Institute of International Management, National Cheng Kung University), Dr. Trung Dam-Huy Thai (Institute of International Management, National Cheng Kung University)

Consumer Reactions Toward IT Infrastructure Upgrade: Evidence from A Nation-Wide Mobile Network Upgrade
- Mr. Yi Zhu (University of Minnesota - Twin Cities), Dr. Jason Chan (University of Minnesota - Twin Cities), Dr. Xuan Bi (University of Minnesota - Twin Cities), Dr. Jun Wu (Beijing University of Posts and Telecommunications)

Impacts of Perceived Robot Eeriness on Future Approach Intentions of Third-party Observers
- Mr. Ross Murray (The University of Texas Rio Grande Valley), Dr. Xiaoqing Sheng (The University of Texas Rio Grande Valley), Dr. Reto Felix (The University of Texas Rio Grande Valley)

Social Media Influencers: Their Impact on Consumers, Firms, and Taboo Topics
- Ms. Jana Grothaus (TU Dortmund), Dr. Sarah Koecher (TU Dortmund), Prof. Hartmut H. Holzmüller (TU Dortmund)

Unpacking the concept of influencers: the moderating role of Social Media Influencers in service failure recovery strategies
- Prof. Wilson Ozuem (University of Cumbria), Prof. Silvia Ranfagni (University of Florence), Ms. Michelle Willis (University of Cum), Prof. Serena Rovai (La Rochelle Business School)

Let's Get Digital: An Exploratory Study of the Impact of Influencers on Digital Wellness
- Ms. Ashley Hass (Texas Tech University), Dr. Debbie Laverie (Texas Tech University)

Candidate sentiment, traditional, owned and earned social media: the role of fan following in influencing voting intentions
- Dr. Marcos Almeida (Federal University of Goiás), Dr. Luiz Paulo Fávero (University of São Paulo), Dr. Valter Vieira (State University of Maringá), Ms. Rafael de Freitas Souza (University of São Paulo)

How YouTube Health Vloggers Influence Viewer Compliance: The Interplay Between Vlogger Characteristics, Parasocial Interaction, and Viewer Characteristics
- Dr. Md Nazmus Sakib (McNeese State University), Dr. MD Al-Emran (McNeese State University)
11am

**Oral: Branding, Innovation and the 4Ps Track - Session 2**

The Evolution of Consumer Brand Evaluation  
*Stage - Stage 6*

Chaired by: Prof. Paula Rodrigues

The Measurement of Brand Activism: Scale Development and Validation  
» Ms. Nuket Serin (FL), Dr. Jayati Sinha (Florida International University)

Consumer's perceptions towards a luxury brand: a comparative evaluation between brand love and brand engagement  
» Prof. Paula Rodrigues (Universidade Lusíada - Norte, COMEGI Research Center), Dr. Ana Sousa (Universidade Lusíada - Norte, COMEGI Research Center), Ms. Catarina Correia (Universidade Lusíada - Norte, COMEGI Research Center)

The Impact of University Location and Ranking on Brand Name and Logo of Cross-Country Higher Education Alliance in China  
» Prof. Jiaxun He (East China Normal University), Dr. Mingyue Zhang (East China Normal University), Ms. Qian Zhang (East China Normal University), Ms. Jingxian Wu (East China Normal University)

Brand Structure and Extension Typicality Effects on the Diagnosticity of Negative Extension Information  
» Prof. Joseph Chang (University of Massachusetts Dartmouth)

12:30pm

**General**

SALESSIG: Managerial Interventions for Enablement of Salespeople's Approaches and Activities  
*Stage - SIG Programming Stage*

Chaired by: Mr. Khashayar Afshar Bakeshloo and Dr. Ashley Goreczny and Dr. Stephanie Mangus and Dr. Huanhuan Shi and Dr. Amin Rostami

Managerial Interventions for Enablement of Salespeople's Approaches and Activities  
» Mr. Khashayar Afshar Bakeshloo (Iowa State University), Dr. Ashley Goreczny (Iowa State University), Dr. Stephanie Mangus (Baylor University), Dr. Huanhuan Shi (Texas A&M University), Dr. Amin Rostami (University of Minnesota Dul)

12:30pm

**General**

Consumer Behavior amidst and beyond the COVID-19 Pandemic  
*Stage - Special Session Stage*

Chaired by: Dr. Alexis Yim and Ms. Yumei Mu and Ms. Yuerong Liu and Mr. Liguo Liu and Ms. Elizabeth Gratz and Mr. Vijay Bharti

Consumer Behavior amidst and beyond the COVID-19 Pandemic  
» Dr. Annie Cui (West Virginia University), Dr. Jody Crosno (West Virginia University), Dr. Stephen He (West Virginia University), Dr. Julian Givi (West Virginia University), Dr. Paula Fitzgerald (West Virginia University), Dr. Alexis Yim (Radford University), Ms. Yumei Mu (West Virginia University), Ms. Yuerong Liu (West Virginia University), Mr. Liguo Liu (West Virginia University), Ms. Elizabeth Gratz (West Virginia University), Mr. Vijay Bharti (West Virginia University)

12:30pm

**Oral: Services, Retailing, and Customer Experience Track - Session 4**

Customer Decision-Making and Pricing  
*Stage - Stage 4*

Chaired by: Ms. Alisa Keller

Spillover of Product Engagement in Add-ons: Side Effects of Network Homogeneity  
» Mr. Pallav Routh (University of Texas at San Antonio), Dr. Richard Gretz (University of Texas at San Antonio), Dr. Daniel Kaimann (Paderborn University)
‘Did I make the right choice?’ - Cognitive Dissonance in a High-Credence Service  
» Dr. Andreas Zehetner (University of Applied Sciences Upper Austria)

Investigating the competition between price and valence of online ratings to influence consumers’ perception of product quality  
» Mr. MohammadAli Koorank Beheshti (Old dominion university), Dr. Yuping Liu-Thompkins (Old dominion university), Mr. Mehdi Koorang Beheshti (Amirkabir University)

CLICK-AND-COLLECT WITH IMPULSE BUYING: PRICING DECISIONS AND THE CHOICE OF PICKUP STATION  
» Prof. Chyi-Mei Chen (Department of Finance, National Taiwan University), Prof. Shan-Yu Chou (Business Administration, National Taiwan University)

A Matter of Price? How Multichannel Price Differentiation and Self-Matching Influence Customer Reactions in the Offline Channel  
» Ms. Alisa Keller (University of Passau)

12:30pm Oral : Marketing Strategy Track - Session 1  
Role of Marketing in Adversities  
Stage - Stage 5  
Chaired by: Mr. Kohei Matsumoto

The Effect of Product Recall by Competitors on Innovation  
» Mr. Kohei Matsumoto (University of Illinois at Chicago), Prof. Anna Shaojie Cui (University of Illinois at Chicago), Prof. Alan J. Malter (University of Illinois at Chicago)

Retailers’ COVID-19 related announcements and their impact on firm value  
» Mr. Navid Bahmani (University of Wisconsin-Milwaukee)

12:30pm Oral : Services, Retailing, and Customer Experience Track - Session 6  
Social Responsibility  
Stage - Stage 6  
Chaired by: Dr. Ji Qi

Scandals and strategic alliances: Spillover effect on partners  
» Mr. Dimitri Simonin (University of Technology Sydney), Dr. Jan Hohberger (Esade Business School)

The Dark Side of Marketing: An Empirical Examination of Marketing’s Role in the Opioid Epidemic  
» Ms. Rachel Ramey (University of Georgia), Dr. Sundar Bharadwaj (University of Georgia)

When Do Business Buyers Offer Suppliers a “Second Chance” After Being Betrayed? The Moderating Role of Emotions of Business Buyers in Betrayal Incidents  
» Dr. Noelle CHUNG (NEOMA Business School), Dr. Kyungwon Lee (University of Michigan-Dearborn)

MULTICULTURAL READINESS IN SERVICE ECOSYSTEMS  
» Mrs. Zahra Daneshfar (Curtin University), Prof. Piyush Sharma (Curtin University), Dr. Russel Kingshott (Curtin University)

A Meta-Analytic Review of The Impact of Service Leadership on Customer-Related Outcomes  
» Dr. Kristina Lindsey Hall (Louisiana State University), Dr. Ji Qi (Grand Valley State University), Dr. Harrison Pugh (The University of North Carolina, Greensboro), Dr. Eric Michel (Northern Illinois University), Ms. Brittany Buis (University of Illinois at Chicago), Dr. Darren Good (Pepperdine University), Dr. Matthew Leon (University of North Florida)

Antecedents of Emotional Motivators for Green Consumption Behavior  
» Prof. Birgit Leisen Pollack (University of Wisconsin Oshkosh)

» Dr. Saeed Shekari (William Paterson University), Dr. Bahar Ashnai (William Paterson University)

Digitization of Interorganizational Relationships: Direct Effects of Benefit Magnitude and Indirect Effects of Benefit Asymmetry on Reseller Profit

» Dr. Talai Osmonbekov (Northern Arizona University), Dr. Brian Gregory (Northern Arizona University)

Franchisee Opportunism – An Emerging Market Perspective

» Dr. Swati Panda (Kennesaw State University), Dr. Satyendra Pandey (Institute of Rural Management), Dr. Audhesh Paswan (University of North Texas), Dr. Lou Pelton (University of North Texas)

Using Computer-Assisted Text Analysis to Investigate Contingencies of Market Orientation and Entrepreneurial Orientation Effects on Firm Financial Performance

» Mr. Philip Wagner (Justus-Liebig-University Giessen), Dr. Stephan Volpers (Justus-Liebig-University Giessen), Dr. Alexander Haas (Justus-Liebig-University Giessen)

Is brand equity growth the CMO's home turf? Examining the contribution of the CMO to brand equity

» Ms. Johanna Alfs (University of Muenster)
Continued from Friday, 6 August

Good for Me and Good for Thee: Performance Implications of Sustainable Innovations in the Consumer Packaged Goods (CPG) Market
» Mr. Youngtak Kim (University of Georgia), Dr. Sundar Bharadwaj (University of Georgia)

Oral: Services, Retailing, and Customer Experience - Session 4
COVID and Consumption
Stage - Stage 6
Chaired by: Dr. Francesca Bonetti

The Role of Time in Customer Reactions for Scarcity Appeals
» Dr. Sungkyu Lee (Akita International University), Dr. Woo Li Ko (Musashino University)

"Group Buying Service Quality Enhances Customer Engagement Behaviours in Mobile Commerce: The Moderating Role of Social Distance"
» Mr. Hamed Azad (UON), Prof. Jamie Carlson (UON), Dr. Jessica Wyllie (UON), Mrs. Azadeh M.Ardakani (UON)

The impact of COVID-19 on cleaning surcharges in the hospitality accommodations
» Mr. Saeed Zal (Old dominion university), Mr. Mohammadali Koorank Beheshti (Old dominion university), Dr. Kristina Harrison (The University of Southern Mississippi)

Investigating shopper value calculus during COVID-10; A replication study
» Mr. Ashish Kakar (Texas Tech University)

GRAPPLING WITH CHANGE: STRATEGIC RESPONSES TO THE CHALLENGES OF IMPLEMENTING CONSUMER-FACING IN-STORE TECHNOLOGY IN FASHION RETAIL
» Dr. Francesca Bonetti (London College of Fashion), Dr. Patsy Perry (Manchester Metropolitan University)